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Product notice

Software terms

This user guide describes features that are
common to most models. Some features may
not be available on your computer.

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to be
bound by the terms of the HP End User License
Agreement (EULA). If you do not accept these
license terms, your sole remedy is to return the
entire unused product (hardware and software)
within 14 days for a full refund subject to the
refund policy of your seller.

Not all features are available in all editions of
Windows. This computer may require upgraded
and/or separately purchased hardware, drivers
and/or software to take full advantage of
Windows functionality. Go to
http://www.microsoft.com for details.

For any further information or to request a full
refund of the price of the computer, please
contact your seller.

Important Notice about Customer Self-Repair Parts
CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be accessed by an
authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair
parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for
Authorized Service Provider only parts," can damage the computer or void your warranty.
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Important Notice about Customer Self-Repair Parts

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place the
device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do not
allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or
clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible
surface temperature limits defined by the International Standard for Safety of Information Technology
Equipment (IEC 60950-1).

v

vi

Safety warning notice
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Product description
Category

Description

Product Name

HP EliteBook Folio 9480m Notebook PC

Processors

Intel® Core® processors:
●

i7-4650U 1.7-GHz (max turbo frequency 3.3-GHz), 4-MB L3 Cache, 15W

●

i7-4600U 2.1-GHz (max turbo frequency 3.3-GHz), 4-MB L3 Cache, 15W

●

i5-4310U 2.0-GHz (max turbo frequency 3.0-GHz), 3-MB L3 Cache, 15W

●

i5-4210U 1.7-GHz (max turbo frequency 2.7-GHz), 3-MB L3 Cache, 15W

Chipset

Integrated with processor

Graphics

Intel UMA Graphics with shared video memory: Intel HD Graphics 5000 (i7-4650U)
Intel UMA Graphics with shared video memory: Intel HD Graphics 4400 (i7-46000U,
i5-4310U, i5-4210U))

Panels

35.6-cm (14.0-in), 3.0-mm, flat/thin backlit, light-emitting diode (LED), highdefinition+ (HD+), AntiGlare (AG), SVA (1600×900) display with and without webcam
35.6-cm (14.0-in), 3.0-mm, flat/thin backlit, LED, HD, AG, SVA (1366×768) display
with and without webcam

Memory

Two customer-accessible/upgradable memory module slots
DDR3L PC3-1600-MHz dual channel support
Supports 16384-MB of system RAM in the following configurations:

Flash cache

●

16384-MB (8192-MB×2)

●

8192-MB (8192-MB×1)

●

4096-MB (4096-MB×1)

32-GB MLC mSATA module, not available on computer models equipped with SSD or
SED.
Supports no Flash cache module configuration.

Hard drive

Solid-state drive

MiniCard SSD

Supports 7.0-mm (.28-in), 6.35-cm (2.5-in) SATA hard drives and solid-state drives
●

500-GB, 7200-rpm, self-encrypting drive (SED)

●

500-GB, 7200-rpm

Supports the following SATA III SSDs:
●

256-GB SED

●

240-GB

●

180-GB

●

128-GB

Supports 120-GB M.2 solid-state drive
No available with flash cache module
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Category

Description

Audio and video

Two stereo speakers
HD audio with DTS Studio Sound
Integrated 720p HD webcam (supports no camera option)
Integrated dual-array microphone

Ethernet

Intel I1218LM 10/100/1000 Ethernet network interface card (NIC) with iAMT
NIC Power Down technology
S3/S4/S5 wake on LAN

Wireless

Integrated wireless local area network (WLAN) options by way of wireless module
Two WLAN antennas built into display assembly
Support for the following WLAN formats:
●

Intel Dual Band Wireless-AC 7260 802.11 AC 2x2 WiFi + BT 4.0 Combo Adapter

●

HP Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi
and Bluetooth 4.0 WLAN module

●

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi and
Bluetooth 4.0 WLAN module for use in Indonesia

Supports no WLAN option
Integrated wireless wide area network (WWAN) options by way of wireless module
Two world-wide/5-band WWAN antennas built into display assembly
Secured by subscriber identity module (SIM, user-accessible behind battery)
Support for the following WWAN formats:
●

HP lt4112 LTE/HSPA+ Mobile Broadband Module

●

HP lt4211 LTE/EV-DO/HSPA+ Gobi 4G Module

●

HP hs3110 HSPA+ Mobile Broadband Module

Supports no WWAN option
Supports WWAN after market option
External media cards

Ports

Secure Digital (SD) flash media slot supporting the following digital card formats:
●

Secure Digital (SD) Memory Card

●

SDHC

●

SDXC

Headphone/Microphone combo
Battery connector
DisplayPort 1.2a
Docking connector
Multi-Pin AC Port
RJ-45 (Ethernet)
USB 3.0 ports (2)
USB 3.0 charging/powered port (1)
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Category

Description
VGA (Dsub 15 pin) supporting: 1920×1200 external resolution @ 60 Hz, hot plug and
unplug and auto-detection for correct output to wide-aspect vs. standard aspect
video

Keyboard/pointing devices

Full chiclet keyboard, backlit, dual-point, spill-resistant with durakeys
Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-zoom
as default
Taps enabled by default
Touchpad on/off button
Touchpad supports 2-way scroll with legend

Power requirements

Supports the following AC adapters:
65-W Smart EM adapter
45-W Smart AC adapter
45-W AC adapter (2-prong) for use in Japan
Supports the following batteries:
●

Primary: 4-cell, 52-Wh, 3.55-Ah battery

●

Secondary: 6-cell, 60-Wh, 2.7-Ah battery

Supports the following power cords:

Security

●

2 wire plug (1.0 m)

●

3 wire plug with ground pin (1.0 m)

●

3 wire plug with ground pin (1.8 m)

Supports security cable lock
Supports fingerprint reader and no fingerprint reader option
Supports Trusted Platform Module (TPM) 1.2 (Infineon, soldered down)
Integrated Smart Card reader (active)
Full volume encryption
HP ProtectTools

Operating system

Preinstalled:
●

Windows 10

●

Windows 10 Professional

●

Windows 8.1 Professional 64 DPK with Windows 7 Professional 64 image

●

Windows 8.1 Professional 64 DPK with Windows 7 Professional 64 image –
MSNA

●

Windows 8.1 EM 64

●

Windows 8.1 CH 64

●

Windows 8.1 ML 64

●

Windows 8.1 Professional 64

●

Windows 8.1 Professional 64 – MSNA
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Category

Description
●

FreeDOS

●

Ubuntu Linux

Restore media
●

DRDVD Windows 7

●

DRDVD Windows 8.1

●

SRDVD Ubuntu

●

Windows 7 Professional 64

●

Windows 8.1 Professional 64

●

Windows 8.1 64-bit

●

Windows 8.1 Country Specific 64-bit

●

Windows 8.1 Emerging Market 64-bit

Web-only support:

Serviceability
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●

Windows 10

●

Windows 10 Professional

●

Windows 8.1 Enterprise 64

●

Windows 7 Professional 64- and 32-bit

●

Windows 7 Enterprise 64- and 32-bit

End user replaceable parts:
●

AC adapter

●

Battery

●

Hard drive

●

Solid-state drive

●

Keyboard

●

Memory module

●

mSATA flash cache

●

WLAN module

●

WWAN module
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External component identification

Display

Component

Description

(1)

WLAN antennas (2)* (select models only)

Send and receive wireless signals to communicate with wireless local
area networks (WLAN).

(2)

WWAN antennas (2)* (select models only)

Send and receive wireless signals to communicate with wireless wide
area networks (WWAN).

(3)

Internal microphones (2)

Record sound.

(4)

Webcam light (select models only)

On: The webcam is in use.

(5)

Webcam (select models only)

Records video and captures photographs. Some models allow you to
video conference and chat online using streaming video.
To use the webcam:
Windows 7: Select Start > All Programs > Communication and Chat
> CyberLink YouCam.
Windows 8.1: Access HP Support Assistant. To access HP Support
Assistant, from the Start screen, select the HP Support Assistant
app.
Windows 10: Type camera in the taskbar search box, and then
select Camera.

(6)

Internal display switch

Turns off the display or initiates Sleep if the display is closed while
the power is on.

Display
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Component

Description
NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices
that applies to your country or region. To access this guide:
Windows 7: Select Start > Help and Support > User Guides.
Windows 8.1: From the Start screen, type support, and then select the HP Support Assistant app.
Windows 10: Select Start, select All apps, select HP Help and Support, and then select HP Documentation.

Top
TouchPad

Component
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Description

(1)

Pointing stick

Moves the pointer and selects or activates items on the screen.

(2)

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on and off.

(4)

TouchPad zone

Moves the pointer and selects or activates items on the screen.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Functions like the right button on an external mouse.

(7)

Right TouchPad button

Functions like the right button on an external mouse.

Chapter 2 External component identification

Lights

Component
(1)

Description
Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state, a power-saving
state. The computer shuts off power to the display and
other unneeded components.

●

Off: The computer is off or in Hibernation. Hibernation is a
power-saving state that uses the least amount of power.

NOTE: For select models, the Intel® Rapid Start Technology
feature is enabled at the factory. Rapid Start Technology allows
your computer to resume quickly from inactivity.
(2)

Microphone mute light

●

Amber: microphone sound is off.

●

Off: microphone sound is on.

(3)

Num lock light

On: Num lock is on.

(4)

Wireless light

White: An integrated wireless device, such as a wireless local area
network (WLAN) device and/or a Bluetooth® device, is on.
NOTE: On some models, the wireless light is amber when all
wireless devices are off.

(5)

Mute light

●

Amber: Computer sound is off.

●

White: Computer sound is on.

(6)

Caps lock light

White: Caps lock is on, which switches the keys to all capital
letters.

(7)

TouchPad light

●

Amber: The TouchPad is off.

●

Off: The TouchPad is on.

Top
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Buttons, speakers, and fingerprint reader (select models only)

Component
(1)

Description
Power button

●

When the computer is off, press the button to turn on the
computer.

●

When the computer is on, press the button briefly to initiate
Sleep.

●

When the computer is in the Sleep state, press the button
briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will
result in the loss of unsaved information.
If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.
NOTE: For select models, the Intel® Rapid Start Technology
feature is enabled at the factory. Rapid Start Technology allows
your computer to resume quickly from inactivity.
To learn more about your power settings, see your power
options:
Windows 7: Select Start > Control Panel > System and Security
> Power Options.
Windows 8.1: From the Start screen, type power, select Power
and sleep settings, and then select Power and sleep from the
list of applications.
Windows 10: Type power in the taskbar search box, and then
select Power and sleep settings.
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Component

Description
– or –
Right-click the Start button, and then select Power Options.

(2)

Wireless button

Turns the wireless feature on or off but does not establish a
wireless connection.

(3)

Volume mute button

Mutes and restores speaker sound.

(4)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a password
logon.

Keys

Component

Description

(1)

esc key

Displays system information when pressed in combination with
the fn key.

(2)

fn key

Executes frequently used system functions when pressed in
combination with a function key, the num lk key, the esc key, or
the b key.

(3)

Windows key

Windows 7: Displays the Windows Start menu.
Windows 8.1: Returns you to the Start screen from an open app
or the Windows desktop.
NOTE: Pressing the Windows key again will return you to the
previous screen.
Windows 10: Opens the Windows Start menu.
NOTE: Pressing the Windows key again will close the Start
menu.

(4)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

Top
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Component
(5)

Description
Embedded numeric keypad

When the keypad is turned on, it can be used like an external
numeric keypad.
Each key on the keypad performs the function indicated by the
icon in the upper-right corner of the key.

(6)

Windows applications key

Windows 7: Displays a shortcut menu for items beneath the
cursor.
Windows 8.1: Displays options for a selected object.
Windows 10: Displays options for a selected object.

(7)

num lk key

Turns the embedded numeric keypad on and off when pressed in
combination with the fn key.
Alternates between the navigational and numeric functions on
the integrated numeric keypad.

Front

Component
(1)

Description
Wireless light

White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.
NOTE: On some models, the wireless light is amber when
all wireless devices are off.

(2)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state, a powersaving state. The computer shuts off power to the
display and other unneeded components.

●

Off: The computer is off or in Hibernation.
Hibernation is a power-saving state that uses the
least amount of power.

NOTE: For select models, the Intel® Rapid Start
Technology feature is enabled at the factory. Rapid Start
Technology allows your computer to resume quickly from
inactivity.
(3)

10

AC adapter/Battery light

Chapter 2 External component identification

●

White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

●

Amber: The computer is connected to external power
and the battery is charged from 0 to 89 percent.

●

Blinking amber: A battery that is the only available
power source has reached a low battery level. When

Component

Description
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

(4)

Hard drive light

●

Off: The battery is fully charged.

●

Blinking white: The hard drive is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

Left

Component

Description

(1)

Power connector

Connects an AC adapter.

(2)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(3)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or
stolen.

(4)

USB 3.0 charging (powered) port

Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner or USB hub. Standard USB ports
will not charge all USB devices or will charge using a low current.
Some USB devices require power and require you to use a
powered port.
NOTE: USB charging ports can also charge select models of
cell phones and MP3 players, even when the computer is off.

(5)

Audio-out (headphone)/Audio-in (microphone)
jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable. Also connects an
optional headset microphone. This jack does not support
optional microphone-only devices.
WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, see the Regulatory, Safety,
and Environmental Notices. To access this guide:

Left
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Component

Description
NOTE: Windows 7: Select Start > Help and Support > User
Guides.
Windows 8.1:
From the Start screen, type support, and then select the HP
Support Assistant app.
‒ or –
From the Windows desktop, click the question mark icon in the
notification area, at the far right of the taskbar.
Windows 10:
Select Start, select All apps, select HP Help and Support, and
then select HP Documentation.
NOTE: When a device is connected to the jack, the computer
speakers are disabled.
Be sure that the device cable has a 4-conductor connector that
supports both audio-out (headphone) and audio-in
(microphone).

(6)

Smart card reader

Supports optional Smart cards.

Right

Component
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Description

(1)

USB 3.0 ports (2)

Each USB 3.0 port connects an optional USB device, such as a
keyboard, mouse, external drive, printer, scanner or USB hub.

(2)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(3)

Memory card reader

Reads optional memory cards that store, manage, share, or
access information.

(4)

External monitor port

Connects an external VGA monitor or projector.

(5)

Docking connector

Connects an optional docking device.

(6)

RJ-45 (network) jack/lights

Connects a network cable.

Chapter 2 External component identification

●

Green (right): The network is connected.

●

Amber (left): The network is showing activity.

Bottom

Component
(1)

Description
Wireless and memory module
compartment

Contains the wireless and memory modules.
CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore computer
functionality, and then contact support through HP
Support Assistant.
To access Help and Support in Windows 7, select Start >
Help and Support.
To access HP Support Assistant in Windows 8.1, from the
Start screen, select the HP Support Assistant app.
Windows 10: Type support in the taskbar search box,
and then select the HP Support Assistant app.
– or –
Click the question mark icon in the taskbar.

(2)

Travel battery connector

Connects an optional travel battery.

(3)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

Bottom
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Component
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Description

(4)

Speakers (2)

Produce sound.

(5)

Hard drive bay

Contains the hard drive.

(6)

Battery release latch

Releases the battery from the battery bay.

(7)

Battery bay and SIM slot

Holds the battery. Supports a wireless subscriber identity
module (SIM). The SIM slot is located inside the battery
bay.

Chapter 2 External component identification

Labels
The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer.
IMPORTANT: Check the following locations for the labels described in this section: the bottom of the
computer, inside the battery bay, under the service door, or on the back of the display.
●

Service label—Provides important information to identify your computer. When contacting support, you
will probably be asked for the serial number, and possibly for the product number or the model number.
Locate these numbers before you contact support.
Your service label will resemble one of the examples shown below. Refer to the illustration that most
closely matches the service label on your computer.

Component
(1)

Serial number

(2)

Product number

(3)

Warranty period

(4)

Model number (select products only)

Component
(1)

Model name (select products only)

(2)

Product number

(3)

Serial number

(4)

Warranty period

●

Regulatory label(s)—Provide(s) regulatory information about the computer.

●

Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval
markings for the countries or regions in which the devices have been approved for use.

Labels
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3

Illustrated parts catalog
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.
NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Illustrated parts catalog on page 16 for details.
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Computer major components
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17

Item

Component

(1)

Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly spare part
information, see Display assembly subcomponents on page 20.

(2)

Keyboard (backlit; includes keyboard cable and pointing stick cable):
NOTE:

(3)

Spare part number

785648-xx1

For a list of keyboard country codes, see Keyboard on page 45.

Top cover
With fingerprint reader board

748352-001

Without fingerprint reader board

748353-001

Touchpad assembly (not illustrated)

822825-001

(4)

Speakers (right and left; include cables)

702869-001

(5)

AC power connector

702875-001

(6)

Smart Card reader (includes cable)

769707-001

(7)

Fan (includes cable)

702859-001

(8)

System board (includes processor and replacement thermal material):
All system boards use the following part numbers:
xxxxxx-001: Windows 7 or non-Windows operating systems
xxxxxx-501: Windows 8.1 Standard operating system
xxxxxx-601: Windows 8.1 or Windows 10 operating system
●

Intel Core i7-4650U processor

769720-xxx

●

Intel Core i7-4600U processor

769719-xxx

●

Intel Core i5-4310U processor

769718-xxx

●

Intel Core i5-4210U processor

769717-xxx

Plastics Kit, includes:
(9a)

SD card insert

(9b)

Hard drive cover

(10)

Heat sink (includes replacement thermal material):

769708-001

(11)

RTC battery

702853-001

(12)

Fingerprint reader board (includes cable)

702845-001

(13)

Base enclosure

702863-001

(14)

Service cover

704441-001

Service cover, RCTO

713547-001

(15)

(16)

Memory modules (PC3L-12800, 1600-MHz):
4-GB

691740-001

8-GB

693374-001

WLAN module:
Intel Dual Band Wireless-AC 7260 802.11 AC 2x2 WiFi + BT 4.0 Combo Adapter
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702877-001
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710663-001

Item

(17)

(18)

(19)

(20)

(21)

Component

Spare part number

HP Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi and Bluetooth
4.0 WLAN module

717379-001

HP Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi and Bluetooth
4.0 WLAN module for use in Indonesia

747833-001

WWAN module:
HP lt4112 LTE/HSPA+ Mobile Broadband Module

740011-001

HP lt4211 LTE/EV-DO/HSPA+ Gobi 4G Module

793116-001

HP hs3110 HSPA+ Mobile Broadband Module

822828-001

Solid-state drive (SSD), M.2:
120-GB, M.2

769712-001

32-GB, M.2

769711-001

Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, connector,
and screws)

702870-001

Solid-state drive (includes bracket, connector, and screws):
256-GB, SATA III, self-encrypting drive (SED)

769716-001

240-GB, SATA III

769715-001

180-GB, SATA III

769714-001

128-GB, SATA III

769713-001

Hard drive (does not include hard drive bracket, connector, or screws):
500-GB, 7200-rpm, 7-mm, self-encrypting drive

703268-001

500-GB, 7200-rpm, 7-mm

703267-001

Battery (Li ion):
4-cell, 52-Wh, 3.55-Ah

687945-001

6-cell, 60-Wh, 2.7-Ah (travel battery; not illustrated)

696621-001

Computer major components
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Display assembly subcomponents

Item

Component

(1)

Display bezel:

(2)
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For use on models with a webcam

769705-001

For use on models without a webcam

769706-001

Webcam/microphone module

769710-001

Microphone module

702873-001

Display Hinge Kit (includes left and right display hinges and left and right hinge covers)

702857-001

(3a)

Display hinge covers (2)

(3b)

Display hinges

(4)

35.6-cm (14.0-in), LED, AntiGlare display panel:

(5a)

Spare part number

HD+

769722-001

HD

769721-001

Antenna Kit, includes:

769704-001

WWAN antenna cables and transceivers
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Item

Component

Spare part number

(5b)

WLAN antenna cables and transceivers

(6)

Display enclosure

748350-001

Display Panel Support Kit (includes WLAN antenna cables and transceivers, WWAN antenna
cables and transceivers, and display enclosure)

769709-001

Mass storage devices

Item

Description

(1)

Hard drive (does not include hard drive bracket or screws):

Spare part number

500-GB, 7200-rpm, 7-mm, SED

703268-001

500-GB, 7200-rpm, 7-mm

703267-001

Solid-State Drive (includes drive bracket, connector, and screws):
256-GB, SATA III, self-encrypting drive (SED)

769716-001

240-GB SSD, SATA III

769715-001

180-GB, SATA III

769714-001

128-GB, SATA III

769713-001

(2a)

Solid-state drive bracket

(2b)

Solid-state drive

Mass storage devices
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Item

Description

(2c)

Drive connector

(3)

Solid-state drive, M.2:

Spare part number

120-GB, M.2

769712-001

32-GB, M.2

769711-001

Hard Drive Hardware Kit (not illustrated), includes:

702870-001

Hard drive connector
Hard drive bracket
Hard drive bracket screws

Miscellaneous parts
Component

Spare part number

AC adapter:
45-W HP Smart AC adapter, 7.4 mm, slim (non-PFC)

744893-001

45-W HP Smart AC adapter, 2 prong (non-PFC)

742437-001

65-W HP Smart AC adapter

693711-001

65-W HP Smart AC adapter for use in India

693710-001

Power cord (3-pin, black, 1.83-m):
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For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-202

For use in Denmark

490371-081

For use in Europe

490371-021

For use in India

490371-D61

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in North America

490371-001

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in Thailand

490371-201
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Component

Spare part number

For use in the United Kingdom and Singapore

490371-031

For use in the United States

490371-001

Power cord (3-pin, black, 1.0-m):
For use in Argentina

755530-D01

For use in Australia

755530-011

For use in Brazil

755530-202

For use in Denmark

755530-081

For use in Europe

755530-021

For use in India

755530-D61

For use in Israel

755530-BB1

For use in Italy

755530-061

For use in Japan

755530-291

For use in North America

755530-001

For use in the People's Republic of China

755530-AA1

For use in South Africa

755530-AR1

For use in South Korea

755530-AD1

For use in Switzerland

755530-111

For use in Taiwan

755530-AB1

For use in Thailand

755530-201

For use in the United Kingdom and Singapore

755530-031

For use in the United States

755530-001

Power cord (2-pin, black, 1.0-m):
For use in Japan

762689-291

DisplayPort to HDMI 1.4 adapter

749288-001

Screw Kit

702846-001

Pointing stick cover

750348-001

Docking station

732252-001

Cable lock docking station

575921-001

HP Ultraslim Keyed Cable Lock

703372-001

Essential Backpack

679923-001

HP Business Backpack

718548-001

HP Business Slim Load Top Case

718549-001

Essential Top Load Case

679921-001

Miscellaneous parts
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Removal and replacement procedures
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screw driver

●

Magnetic screw driver

●

Phillips P0 and P1 screw drivers

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying
screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care
when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the
reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat
the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught
or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables
tear easily.
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Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is
off or in Hibernation, turn the computer on, and then shut it down through the operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure
that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine
the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many
cases, ESD contains enough power to alter device parameters or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its
life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal components,
observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines described in this
section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
CAUTION:

A product can be degraded by as little as 700 V.

Grounding guidelines
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Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to avoid
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and
equipment.

●

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Grounding guidelines
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips
to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be
used at standing workstations and are compatible with most types of shoes or boots. On conductive
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance
between the operator and ground. To be effective, the conductive must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Removal and replacement procedures for
Customer Self-Repair parts
CAUTION: The Customer Self-Repair program is not available in all locations. Installing a part not supported
by the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer
Self-Repair is supported in your location.
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Component replacement procedures
This chapter provides removal and replacement procedures for Customer Self-Repair parts.
There are as many as 14 screws that must be removed, replaced, or loosened when servicing Customer SelfRepair parts. Make special note of each screw size and location during removal and replacement.
NOTE: Please read and follow the procedures described here to access and replace Customer Self-Repair
parts successfully.
NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Illustrated parts catalog on page 16 for details.

Battery
Description

Spare part number

4-cell, 52-Wh, 3.55-Ah, Li ion battery

687945-001

6-cell, 60-Wh, 2.7-Ah, Li ion travel battery

696621-001

Before disassembling the computer, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

Remove the battery:
1.

Position the computer upside-down on a flat surface.

2.

Slide the battery release latch (1) to release the battery.

Component replacement procedures
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3.

Slide the battery outward (2), lift the outer edge of the battery (3), and then remove it from the
computer (3).

When installing the battery:
1.

Insert the battery connector end of the battery into the bay, aligning it to the left edge.

2.

Slide the battery into the bay until it drops and the latch snaps, and then slide the latch to the left to lock
the battery.

NOTE:

In the locked position there will be no red color shown in the latch slot.

NOTE:

This section applies only to computer models with WWAN capability.

SIM
NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the computer. Be
sure that the SIM is reinserted in the SIM slot after reassembling the computer.
The SIM slot is located inside the battery bay on the right side.
Before removing the SIM, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

Remove the SIM:
1.
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Press in on the SIM (1). (The module is partially ejected from the SIM slot.)
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2.

Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Hard drive cover
NOTE:

The hard drive cover is available in the Plastics kit, spare part number 702877-001.

Description

Spare part number

Plastics kit

702877-001

Before removing the hard drive cover, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

Remove the hard drive cover:
1.

Loosen the 2 captive hard drive cover screws (1).

2.

Slide the hard drive cover away from the computer (2), and then lift the cover off the computer (3).

Reverse the removal procedures to install the hard drive cover.
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Hard drive/SSD drive
NOTE:

The hard drive spare part kit does not include the hard drive bracket, connector, or screws.

The solid-state drive spare part kit includes the Hard Drive Hardware Kit, which includes the bracket,
connector, and screws..
Description

Spare part number

Hard drive (does not include hard drive bracket or screws):
500-GB, 7200-rpm, 7-mm, SED

703268-001

500-GB, 7200-rpm, 7-mm

703267-001

Solid-state drive (includes bracket, connector, and screws):
256-GB, SATA III, self-encrypting drive (SED)

769716-001

240-GB, SATA III

769715-001

180-GB, SATA III

769714-001

128-GB, SATA III

769713-001

Hard Drive Hardware Kit (includes hard drive bracket, connector, and screws)

702870-001

Before removing the hard drive, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

Remove the hard drive:
1.

Loosen the 4 captive hard drive screws (1) that secure the drive to the computer.

2.

Pull the hard drive tab (2) upward to disconnect the hard drive.
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3.

Lift the hard drive, and then pull the hard drive out of the hard drive bay.

4.

If it is necessary to disassemble the hard drive, perform the following steps:
a.

Remove the connector from the hard drive (1).

b.

Remove the four Phillips PM3.0×4.0 screws (2) that secure the hard drive bracket to the hard drive.

c.

Remove the hard drive bracket (3) from the hard drive. The hard drive bracket, connector, and
screws are available in the Hard Drive Hardware Kit, spare part number 702870-001.

Reverse this procedure to reassemble and install the hard drive.
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mSATA drive
Description

Spare part number

120-GB drive, M.2

769712-001

32-GB drive, M.2

769711-001

Before removing the mSATA drive follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

Remove the mSATA drive:
1.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the drive to the system board. (The drive tilts
up.)
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35

2.

Remove the drive (2) by pulling it away from the slot at an angle.
NOTE: mSATA drives are designed with a notch to prevent incorrect insertion.

Reverse this procedure to install the mSATA drive.
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RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided tape)

702853-001

Before removing the RTC battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

2.

Detach the RTC battery (2) from the computer.

3.

Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Service cover
Description

Spare part number

Service cover

704441-001

Service door (RCTO)

713547-001

Before removing the service cover, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

Remove the service cover:
1.

Loosen the 5 captive Phillips screws (1) that secure the cover to the computer.

2.

Tilt the door up from the computer slightly (2), and then lift the cover up and off the computer (3).

Reverse the removal procedures to install the service cover.
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Memory module
NOTE:

Primary and expansion memory is installed in a stacked configuration in the bottom of the computer.

Description

Spare part number

4-GB memory module (PC3L, 12800, 1600-MHz)

691740-001

8-GB memory module (PC3L, 12800, 1600-MHz)

693374-001

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may result in
various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then click Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

6.

Remove the service cover Service cover on page 38).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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2.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the memory
module slot.
NOTE: The computer uses two memory slots. The top slot houses the expansion memory module and
the bottom slot houses the primary memory module.

Reverse this procedure to install a memory module.
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WWAN module
NOTE:

The WWAN module and the WLAN module are not interchangeable.

Description

Spare part number

HP lt4112 LTE/HSPA+ Mobile Broadband Module

740011-001

HP lt4211 LTE/EV-DO/HSPA+ Gobi 4G Module

793116-001

HP hs3110 HSPA+ Mobile Broadband Module

822828-001

Before removing the WWAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

6.

Remove the service cover (see Service cover on page 38).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue
WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2.

Remove the two Phillips PM2.0×3.0 screws (2) that secure the WWAN module to the system board. (The
WWAN module tilts up.)
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3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.
NOTE: WWAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module
Description

Spare part number

Intel Dual Band Wireless-AC 7260 802.11 AC 2x2 WiFi + BT 4.0 Combo Adapter

710663-001

HP Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi and Bluetooth 4.0 WLAN
module

717379-001

Intel Dual Band Wireless-N 7260AN 802.11 a/b/g/n (2x2) combination WiFi and Bluetooth 4.0 WLAN
module for use in Indonesia

747833-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in your
country or region. If you replace the module and then receive a warning message, remove the module to
restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

6.

Remove the service cover (see Service cover on page 38).

Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”.
The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”. If the
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable connects to
the middle terminal on the WLAN module.

2.

Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board. (The
WLAN module tilts up.)
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3.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Keyboard
In this section, the first table provides the main spare part number for the keyboard. The second table
provides the country codes.
Description

Spare part number

Keyboard

785648-xx1

For use in country
or region

Spare part
number

For use in country
or region

Spare part
number

For use in country
or region

Spare part
number

Belgium

-A41

Israel

-BB1

Slovenia

-BA1

Brazil

-201

Italy

-061

South Korea

-AD1

Bulgaria

-261

Japan

-291

Spain

-071

Canada

-DB1

Latin America

-161

Sweden and Finland

-B71

Czech Republic
and Slovakia

-FL1

The Netherlands

-B31

Switzerland

-BG1

Denmark

-081

Northern Africa

-FP1

Taiwan

-AB1

France

-051

Norway

-091

Thailand

-281

Germany

-041

Portugal

-131

Turkey

-141

Greece

-151

Romania

-271

United Kingdom

-031

Hungary

-211

Russia

-251

United States

-001

Iceland

-DD1

Saudi Arabia

-171

India

-D61

Before removing the keyboard, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).

5.

Remove the hard drive cover (see Hard drive cover on page 32).

6.

Remove the service cover (see Service cover on page 38).

Remove the keyboard:
1.

Loosen the 4 captive Phillips screws that secure the keyboard to the computer.
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2.

Rest and secure the computer on its right side.

3.

Partially open the computer.

4.

Insert a screw driver or similar thin tool into the keyboard release opening near the fan, and then press
on the back of the keyboard until the keyboard disengages from the computer.

5.

Turn the computer right-side up with the front toward you.
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6.

Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it rests
upside down on the palm rest (3).

7.

Release and disconnect the following connectors and cables:
●

Release the pointing stick connector (1) and remove the cable (2).

●

Release the large keyboard connector (3) and remove the cable (4).

●

Release the small keyboard connector (5) and remove the cable (6).
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8.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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6

Removal and replacement procedures for
Authorized Service Provider parts
CAUTION: Components described in this chapter should only be accessed by an authorized service provider.
Accessing these parts can damage the computer or void the warranty.
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.
There are as many as 53 screws that must be removed, replaced, or loosened when servicing Authorized
Service Provider only parts. Make special note of each screw size and location during removal and
replacement.
NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Illustrated parts catalog on page 16 for details.
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Display assembly components (panel, bezel, webcam, microphone)
All display assemblies include WLAN antenna transceivers and cables. WWAN models also include 2 WWAN
antenna transceivers and cables.
Full hinge-up displays are not spared.
This section describes removing components that do not require that you entirely remove the display
assembly from the computer. You can remove the display bezel, webcam/microphone module, and display
panel with the display assembly still attached to the computer.
To remove the remaining display components, including the display brackets, antennas, and enclosure, you
must remove the entire display assembly from the computer. See Display assembly on page 67 for more
information about removing the remaining components.
Description

Spare part number

Display panels
35.6-cm (14.0-in), HD+, anti-glare, LED

769722-001

35.6-cm (14.0-in), HD anti-glare, LED

769721-001

Display bezels
For use with models with a webcam

769705-001

For use with models without a webcam

769706-001

Webcam module with microphone

769710-001

Microphone module

702873-001

Before removing the display panel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 29).

Remove the display assembly components:
1.

Position the computer upright, with the front toward you.

2.

Open the computer as far as possible.

3.

If it is necessary to replace the display bezel or any of the display assembly subcomponents:
a.
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Flex the inside edges of the bottom edge (1), the left and right sides (2), and the top edge (3) of
the display bezel until the bezel disengages from the display enclosure.

Chapter 6 Removal and replacement procedures for Authorized Service Provider parts

b.

4.

5.

Remove the display bezel (4). The display bezel is available using spare part number 769705-001
on models with a webcam and 769706-001 on models without a webcam.

If it is necessary to replace the webcam/microphone module:
a.

Detach the webcam/microphone module (1) from the display enclosure. (The webcam/microphone
module is attached to the display enclosure with double-sided tape.)

b.

Disconnect the cable (2) from the webcam/microphone module.

c.

Remove webcam/microphone module. The webcam module is available using spare part number
769710-001. The microphone module is available using spare part number 702873-001.

If it is necessary to replace the display panel:
a.

Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the display enclosure.
●

769721-001 — 35.6-cm (14.0-in), LED, HD, AntiGlare display panel

●

769722-001 — 35.6-cm (14.0-in), LED, HD+, AntiGlare display panel
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b.

Rotate the top of the display panel downward (1).

c.

Lift the tape that secure the display cable connector on the panel (2), and then disconnect the
cable (3) from the connector (4).

Reverse this procedure to reassemble and install the display assembly components.
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Base enclosure
Description

Spare part number

Base enclosure

702863-001

Before removing the base enclosure, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

Remove the base enclosure:
1.

Close the computer and position it upside down.

2.

Remove the WLAN (1) and WWAN (2) antennas from the routing path (3) in the base enclosure.
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3.

Remove the 13 Torx PM2.0×5.0 screws that secure the base enclosure to the computer.

4.

Remove the 7 Torx PM2.0×3.0 screws from the battery bay that secure the base enclosure to
the computer.
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5.

Lift the base enclosure (1) off the computer while threading the antenna cables through the hole in the
base enclosure (2).

Reverse this procedure to install the base enclosure.

Touchpad
Before removing the touchpad, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

Remove the touchpad:
1.

Remove the 2 Phillips PM2.0×3.0 screws (1) that secure the touchpad to the computer.
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2.

Lift the touchpad from the computer (2).

3.

Remove the touchpad.

Reverse this procedure to install the touchpad.
NOTE: When replacing the touchpad, make sure to install the screws into holes closer to the edge of
computer.
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Power connector
Description

Spare part number

Power connector

702875-001

Before removing the power connector, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

Remove the power connector:
1.

Position the base enclosure with the front toward you.

2.

Disconnect the power connector cable from the system board (1).

3.

Lift the power connector from the computer (2).

4.

Remove the power connector.

Reverse this procedure to install the power connector.
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Fan
Description

Spare part number

Fan (includes cable)

702859-001

Before removing the fan, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

Remove the fan:
1.

Disconnect the fan cable (1) from the system board.

2.

Loosen the 2 captive Phillips screws (2) that secure the fan to the top cover.

3.

Remove the fan (3).

Reverse this procedure to install the fan.
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System board
NOTE:

The system board spare part kit includes replacement thermal material.

All system boards use the following part numbers:
xxxxxx-001: Windows 7 or non-Windows operating systems
xxxxxx-501: Windows 8.1 Standard operating system
xxxxxx-601: Windows 8.1 or Windows 10 operating system
Description

Spare part number

Intel Core i7-4650U processor

769720-xxx

Intel Core i7-4600U processor

769719-xxx

Intel Core i5-4310U processor

769718-xxx

Intel Core i5-4210U processor

769717-xxx

Before removing the system board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Fan (see Fan on page 58)

e.

Keyboard (see Keyboard on page 45)

f.

Base enclosure (see Base enclosure on page 53)

NOTE: When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
●

SIM (see SIM on page 30, if applicable)

●

Memory module (see Memory module on page 39)

●

WWAN module (see WWAN module on page 41)

●

WLAN module (see WLAN module on page 43)

●

Heat sink (see Heat sink on page 62)

Remove the system board:
1.

Disconnect the following cables:
●

(1): Right speaker cable

●

(2): Display panel
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●

(3): Left speaker cable

●

(4): Touchpad

●

(5): Smart card reader

2.

Remove the 2 Phillips PM2.0×4.0 screws that secure the system board to the computer.

3.

Lift the left side of the system board up at an angle (1).
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4.

Pull the system board away from and out of the computer (2), making sure the connectors on the right
side of the board (3) are clear of the computer.
NOTE: To avoid breaking the board, support the right side of the system board near the heat sink (3)
as you lift it up and out of the computer.

Reverse this procedure to install the system board.
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Heat sink
NOTE:

The heat sink spare part kit includes replacement thermal material.

Description

Spare part number

Heat sink

769708-001

Before removing the heat sink, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

WLAN module (see WLAN module on page 43)

e.

WWAN module (see WWAN module on page 41)

f.

Fan (see Fan on page 58)

g.

Keyboard (see Keyboard on page 45)

h.

Base enclosure (see Base enclosure on page 53)

i.

System board (see System board on page 59)

Remove the heat sink:
1.
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Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips screws (1)
that secure the heat sink to the system board.
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2.

Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the
system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink, processor, and system board spare part kits.
The following illustration shows the replacement thermal material locations. Thermal paste is used on
the heat sink (1) and the processor (2).

Reverse this procedure to install the heat sink.
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Speaker assembly
Description

Spare part number

Speaker assembly (includes cable)

702869-001

Before removing the speaker assembly, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

f.

Fan (see Fan on page 58)

g.

System board (see System board on page 59)

Remove the speaker assembly:
1.

Remove the 2 Phillips PM2.0×3.0 screws (1) that secure each speaker to the computer.

2.

Remove the speakers (2) from the computer.

Reverse this procedure to install the speakers.
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Smart card board
Description

Spare part number

Smart card board (includes cable)

769707-001

Before removing the smart card reader, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29).
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

f.

Fan (see Fan on page 58)

g.

System board (see System board on page 59)

Remove the smart card board:
1.

Remove the Phillips PM2.0×2.5 broadhead screw (1) that secures the board to the computer.

2.

Rotate the board upward (2) at an angle, and then remove it from the computer (3).

Reverse the removal procedures to install the smart card board.
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Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes cable)

702845-001

Before removing the fingerprint reader board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

Keyboard (see Keyboard on page 45)

e.

Base enclosure (see Base enclosure on page 53)

f.

Fan (see Fan on page 58)

g.

System board (see System board on page 59)

Remove the fingerprint reader board:
1.

Position the system board upside down.

2.

Disconnect the fingerprint reader board cable from the system board connector, and then remove the
assembly.

3.

Remove the fingerprint reader board and cable.

Reverse this procedure to install the fingerprint reader board.
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Display assembly
This section describes removing components that require you to completely remove the display panel. For
more information about removing display components that do not require that you remove the assembly
from the computer, see Display assembly components (panel, bezel, webcam, microphone) on page 50.
NOTE:

The display assembly is spared at the subcomponent level only.

Before removing the display assembly, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 29), and then remove the following components:
a.

Hard drive cover (see Hard drive cover on page 32)

b.

Hard drive (see Hard drive/SSD drive on page 33)

c.

Service cover (see Service cover on page 38)

d.

WLAN module (see WLAN module on page 43)

e.

WWAN module (see WWAN module on page 41)

f.

Fan (see Fan on page 58)

g.

Keyboard (see Keyboard on page 45)

h.

Base enclosure (see Base enclosure on page 53)

Remove the display assembly:
1.

Disconnect the display panel cable (1) from the system board.

2.

Release the display panel cable from the routing channel (2).

3.

Open the computer and position it with the base enclosure on a table and the display hanging down.
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NOTE: Be sure to support the display when removing the screws.
4.

Remove the four Phillips PM2.5×4.0 screws (1) that secure the display assembly to the computer.

5.

Remove the display assembly from the top cover (2).

6.

To remove the display bezel:
a.

Flex the inside edges of the bottom edge (1), the left and right sides (2), and the top edge (3) of
the display bezel until the bezel disengages from the display enclosure.

b.

Remove the display bezel (4). The display bezel is available using spare part number 769705-001
on models with a webcam and 769706-001 on models without a webcam.
NOTE: For this procedure the display will not be connected to the computer as shown in the
following image.
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7.

To remove the display panel:
NOTE: For this procedure the display will not be connected to the computer as shown in the following
images.
a.

Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the display enclosure.
Display panels are available using the following spare part numbers:

b.

●

769721-001 — 35.6-cm (14.0-in), LED, HD, AntiGlare display panel

●

769722-001 — 35.6-cm (14.0-in), LED, HD+, AntiGlare display panel

Rotate the top of the display panel downward (1).
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c.

Lift the tape that secure the display cable connector on the panel (2), and then disconnect the
cable (3) from the connector (4).
NOTE: For this procedure the display will not be connected to the computer as shown in the
following image.

8.

If it is necessary to replace the display hinges:
Display hinge covers and hinges are available in the Display Hinge Kit, spare part number 702857-001.
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a.

Remove the Phillips broadhead PM2.0×2.5 screw (1) that secures each hinge cover to the
display enclosure.

b.

Remove the display hinge covers (2) from atop the hinges.
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9.

c.

Remove the 2 broadhead Phillips PM2.0×2.5 screws (1) that secure each display hinge to the
display enclosure.

d.

Lift the display hinges off the display enclosure (2).

If it is necessary to replace the WLAN antenna cables and transceivers:
WLAN and WWAN antennas are available in the Antenna Kit, spare part number 769704-001.
a.

Release the WLAN antenna transceivers (1) from the clips built into the display enclosure. (The
WLAN antenna transceivers are attached to the display enclosure with double-sided tape.)

b.

Detach the WLAN antenna cables from the routing channels (2) built into the display enclosure.

c.

Remove the WLAN antenna cables and transceivers. The WLAN antenna cables and transceivers are
included in the Antenna Kit, spare part number 769704-001.
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10. If it is necessary to replace the WWAN antenna cables and transceivers:
WLAN and WWAN antennas are available in the Antenna Kit, spare part number 769704-001.
a.

Release the WWAN antenna transceivers (1) from the clips built into the display enclosure. (The
WWAN antenna transceivers are attached to the display enclosure with double-sided tape.)

b.

Detach the WWAN antenna cables from the routing channels (2) built into the display enclosure.

c.

Remove the WWAN antenna cables and transceivers. The WWAN antenna cables and transceivers
are included in the Antenna Kit, spare part number 769704-001.

Reverse this procedure to reassemble and install the display assembly.
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Computer Setup (BIOS) and MultiBoot in
Windows 7

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2.

Press f10 to enter Computer Setup.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen,
or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Main > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE:

Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed on the
computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select Main > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Access Help and Support by selecting Start > Help and Support.

2.

Select Updates and tune-ups, and then select Check for HP updates now.

3.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:
1.

Select Start > Computer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include
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optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices
contain bootable media or files that the computer needs to start and operate properly.
NOTE:

Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot order in
Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options
menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.

4.

To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.
– or –
To move the device down in the boot order, use a pointing device to click the down arrow, or press the key.

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
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1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

Press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the
computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press
enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When
0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
●

To specify a boot device from the Express Boot menu, select your preference within the allotted time,
and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to
expire.

Using MultiBoot
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Computer Setup (BIOS) and MultiBoot in
Windows 8

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2.

Press f10 to enter Computer Setup.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen,
or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Main > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE:

Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed on the
computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select Main > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

From the Start screen, type hp support assistant, and then select the HP Support Assistant app.

2.

Click Updates and tune-ups, and then click Check for HP updates now.

3.

Follow the on-screen instructions.

4.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:
1.

From the Start screen, type file, and then select File Explorer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.
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Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices
contain bootable media or files that the computer needs to start and operate properly.
NOTE:

Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot order in
Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options
menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select one of the following options:
●

Advanced > Boot Options > UEFI Boot Order > UEFI Hybrid

●

Advanced > Boot Options > UEFI Boot Order > UEFI Native Boot mode

●

Advanced > Boot Options > Legacy Boot Order > Legacy Boot Mode

Press enter.
4.

To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.
– or –
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To move the device down in the boot order, use a pointing device to click the down arrow, or press the key.
5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

Press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the
computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select Advanced > Boot Options > MultiBoot Express Boot
Popup Delay (Sec), and then press enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When
0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.
– or –
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
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●

To specify a boot device from the Express Boot menu, select your preference within the allotted time,
and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to
expire.
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Computer Setup (BIOS), TPM, and HP Sure
Start in Windows 10

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
▲

Start Computer Setup.
●

Computers or tablets with keyboards:
▲

●

Turn on or restart the computer, and when the HP logo appears, press f10 to enter Computer
Setup.

Tablets without keyboards:
▲

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F10 to enter Computer Setup.

Navigating and selecting in Computer Setup
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or
use a pointing device to select the item.
NOTE: On tablets without keyboards, you can use your finger to make selections.

●

To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or
use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow
the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

●

To save your changes and exit Computer Setup menus:
Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Start Computer Setup. See Starting Computer Setup on page 83.

2.

Select Main, and then select Apply Factory Defaults and Exit.
NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory
Defaults and Exit.

3.

Follow the on-screen instructions.

4.

To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.
– or –
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE:
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Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version
To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your
computer.
BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup. See Starting Computer Setup on page 83.

2.

Select Main, and then select System Information.

3.

To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
– or –
Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 85.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Type support in the taskbar search box, and then select the HP Support Assistant app.
– or –
Select the question mark icon in the taskbar.

2.

Select Updates, and then select Check for updates and messages.

3.

Follow the on-screen instructions.

4.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
Make a note of the path to the location on your hard drive where the BIOS update is downloaded.
You will need to access this path when you are ready to install the update.
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NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:
1.

Type file in the taskbar search box, and then select File Explorer.

2.

Select your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder that contains the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Changing the boot order using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Access the Boot Device Options menu:
●

Computers or tablets with keyboards:
▲

●

Tablets without keyboards:
▲

2.

Turn on or restart the computer, and when the HP logo appears, press f9 to enter the Boot
Device Options menu.

Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

Select a boot device, then press enter.

TPM BIOS settings (select products only)
IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure
that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or
licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM
which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will
not be responsible for any related liabilities.
TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup
(BIOS).
NOTE:

If you change the TPM setting to Hidden, TPM is not visible in the operating system.

To access TPM settings in Computer Setup:

86

1.

Start Computer Setup. See Starting Computer Setup on page 83.

2.

Select Security, select TPM Embedded Security, and then follow the on-screen instructions.
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Using HP Sure Start (select products only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors the
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
automatically restores the BIOS to its previously safe state, without user intervention.
HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default
configuration. The default configuration can be customized by advanced users.
To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your
country. Select Drivers & Downloads, and then follow the on-screen instructions.

Using HP Sure Start (select products only)
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10 HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic
tests to determine whether the computer hardware is functioning properly. The tool runs outside the
operating system so that it can isolate hardware failures from issues that are caused by the operating system
or other software components.
NOTE: To start BIOS on a convertible computer, your computer must be in notebook mode and you must use
the keyboard attached to your tablet. The on-screen keyboard, which displays in tablet mode, cannot access
BIOS.
To start HP PC Hardware Diagnostics UEFI:
1.

Start BIOS:
●

Computers or tablets with keyboards:
▲

●

Turn on or restart the computer, quickly press esc.

Tablets without keyboards:
▲

Turn on or restart the tablet, and then quickly hold down the volume down button.
- or Turn on or restart the tablet, and then quickly hold down the Windows button.

2.

Press or tap f2.
The BIOS searches three places for the diagnostic tools, in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 88.

3.

b.

Hard drive

c.

BIOS

When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions. On a tablet, press the volume down button to stop a diagnostic test.

NOTE:

If you need to stop a diagnostic test on computers or tablets with a keyboard, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
There are two options to download HP PC Hardware Diagnostics to a USB device:
Download the latest UEFI version:
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1.

Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2.

In the HP PC Hardware Diagnostics section, click the Download link, and then select Run.
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Download any version of UEFI for a specific product:
1.

Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2.

Click Drivers & Downloads.

3.

In the text box, enter the product name, and then click Go.
– or –
Click Find Now to let HP automatically detect your product.

4.

Select your computer, and then select your operating system.

5.

In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version
you want.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
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11 Backup and recovery in Windows 7
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you
ever need to. These tools along with an optional external hard drive, a network drive, or an optional external
optical drive will help you return your computer to a proper working state, all with simple steps. This section
provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original
operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery
DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc
Creator on page 90.

2.

Use Windows Backup and Recovery tools to perform the following:
●

Back up individual files and folders

●

Back up your entire hard drive (select models only)

●

Create system repair discs (select models only) with an optional external optical drive

●

Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.
In case of system failure, you can use the backup files to restore the contents of your computer. See Backing
up your information on page 91.

Guidelines
●

When creating recovery media or backing up to discs, use any of the following types of discs (purchased
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type
of optical drive you are using.

●

Be sure that the computer is connected to AC power before you start the recovery media creation
process or the backup process.

Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After
you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This
recovery media allows you to reinstall your original operating system as well as select drivers and
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applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery
DVDs:
●

Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

●

Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media
NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that
media will not be available after you create a Windows DVD.
To create the Windows DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Windows disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

Backing up your information
You should create system repair media and your initial backup immediately after initial system setup. As you
add new software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. You should also create Windows system repair media (select models only) which
can be used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or optional external
optical discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.

Creating recovery media and backups
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To create a backup using Windows Backup and Restore:
NOTE:

The backup process may take over an hour, depending on file size and the speed of the computer.

1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models only), or
create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you have
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent
Windows from starting correctly.

●

f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard
drive image. The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you
previously created (select models only), you must purchase Windows 7 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 7 operating system
media on page 93.

Using the Windows recovery tools
Using the Windows recovery tools, you can:
●

Recover individual files

●

Restore the computer to a previous system restore point

●

Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics
in Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models only),
or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have
created and any software installed on the computer are permanently removed. When reformatting is
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities
from the backup used for recovery.
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1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition.
To check for the Windows partition, select Start > Computer.
NOTE: If the Windows partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system DVD and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 93.

3.

If the Windows partition is listed, restart the computer, and then press f8 before the Windows operating
system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start > Help
and Support.

Using f11 recovery tools (select models only)
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer, click
Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system media and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 93.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the ESC
key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using Windows 7 operating system media
If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the
operating system.
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.

Performing a system recovery
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To initiate recovery using a Windows 7 operating system DVD:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
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1.

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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12 Backup and recovery in Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and folders,
back up your entire hard drive, create system repair media (select models only) by using an optional external
optical drive, or create system restore points. In case of system failure, you can use the backup files to restore
the contents of your computer.
From the Start screen, type restore, click Settings, and then select from the list of displayed options.
NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Windows Help and Support.
In case of system instability, HP recommends that you print the recovery procedures and save them for later
use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. For more information, see Windows Help and Support.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair media
and your initial backup immediately after initial system setup. As you add new software and data files, you
should continue to back up your system on a regular basis to maintain a reasonably current backup.
For more information on the Windows backup features, see Windows Help and Support.

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you have
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent
Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you
previously created (select models only), you must purchase Windows operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows operating system
media (purchased separately) on page 97.

Using the Windows recovery tools
To recover information you previously backed up, see Windows Help and Support for steps on restoring files
and folders.
To recover your information using Automatic Repair, follow these steps:

Backing up your information
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have
created and any software installed on the computer are permanently removed. When reformatting is
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities
from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Recovery Image partition and the Windows partition.
From the Start screen, type file, and then click File Explorer.
– or –
From the Start screen, type pc, and then select This PC.
NOTE: If the Windows partition and the Recovery Image partition are not listed, you must recover your
operating system and programs using the Windows operating system DVD and the Driver Recovery
media (both purchased separately). For additional information, see Using Windows operating system
media (purchased separately) on page 97.

3.

If the Windows partition and the Recovery Image partition are listed, restart the computer by pressing
and holding the shift key while clicking Restart.

4.

Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search for
these topics in Windows Help and Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc, and
then select This PC.
NOTE: If the Recovery Image partition is not listed, you must recover your operating system and
programs using the Windows operating system media and the Driver Recovery media (both purchased
separately). For additional information, see Using Windows operating system media (purchased
separately) on page 97.
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3.

If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using Windows operating system media (purchased separately)
To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers booklet
included with the computer. You can also find contact information from the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
CAUTION: Using a Windows operating system media completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.
To initiate a full install of the operating system using a Windows operating system DVD:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Insert the Windows operating system DVD into the optional external optical drive, and then restart the
computer.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the installation is completed:
1.

Eject the Windows operating system media and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh or Windows Reset
When your computer is not working properly and you need to regain system stability, the Windows Refresh
option allows you to start fresh and keep what is important to you.
The Windows Reset option allows you to perform detailed reformatting of your computer, or remove personal
information before you give away or recycle your computer. For more information on these features, see
Windows Help and Support.

Using HP Software Setup
HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from
the system.
1.

From the Start screen, type HP Software Setup.

2.

Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.

Performing a system recovery
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13 Backup and recovery in Windows 10
This chapter provides information about the following processes. The information in the chapter is standard
procedure for most products.
●

Creating recovery media and backups

●

Restoring and recovering your system

For additional information, refer to the HP support assistant app.
▲

Type support in the taskbar search box, and then select the HP Support Assistant app.
‒ or –
Click the question mark icon in the taskbar.

IMPORTANT: If you will be performing recovery procedures on a tablet, the tablet battery must be at least
70% charged before you start the recovery process.
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning any recovery process.

Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your computer model.
●

Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. For
information on creating recovery media, see Creating HP Recovery media (select products only)
on page 98. For information on the recovery options that are available using the recovery media, see
Using Windows tools on page 99.

●

Use Windows tools to create system restore points and create backups of personal information.
For more information, see Recovering using HP Recovery Manager on page 100.
NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)
If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer, and then select This PC.
●
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If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery
media for your system from support. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.
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You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 99.
●

If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the
original operating system and software programs that were installed at the factory and then configures
the settings for the programs. HP Recovery media can also be used to customize the system or restore
the factory image if you replace the hard drive.
—

Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

—

HP Recovery Manager examines the computer and determines the required storage capacity for
the media that will be required.

—

To create recovery discs, your computer must have an optical drive with DVD writer capability, and
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a highquality blank USB flash drive.

—

If your computer does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

—

Be sure that the computer is connected to AC power before you begin creating the recovery media.

—

The creation process can take an hour or more. Do not interrupt the creation process.

—

If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 100.

Using Windows tools
You can create recovery media, system restore points, and backups of personal information using Windows
tools.
NOTE:

If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.
▲

Select the Start button, and then select the Get started app.

Using Windows tools
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Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:
IMPORTANT:
●

Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information see the Get started app.
▲

●

Not all methods are available on all products.

Select the Start button, and then select the Get started app.

If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/or
applications option (select products only) of HP Recovery Manager to reinstall the individual application
or driver.
▲

Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

●

If you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 100. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 98.

●

On select products, if you want to recover the computer's original factory partition and content, or if you
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 100.

●

On select products, if you want to remove the recovery partition to reclaim hard drive space, HP
Recovery Manager offers the Remove Recovery Partition option.
For more information, see Removing the HP Recovery partition (select products only) on page 103.

Recovering using HP Recovery Manager
HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 98.

What you need to know before you get started
●

HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.
IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
computer issues.

●

HP Recovery media must be used if the computer hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 98.

●

To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 98.

●

If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the computer. You can also find contact information from the HP
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website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.
IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.
Using HP Recovery media, you can choose from one of the following recovery options:
NOTE:

Only the options available for your computer display when you start the recovery process.

●

System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

●

Factory Reset—Restores the computer to its original factory state by deleting all information from the
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)
The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.
To start HP Recovery Manager from the HP Recovery partition:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps (select products only).
1.

Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.
- orFor computers or tablets with keyboards attached, press f11 while the computer boots, or press and
hold f11 as you press the power button.
For tablets without keyboards:
Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.
- or Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.

2.

Select Troubleshoot from the boot options menu.

3.

Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover
You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.
1.

If possible, back up all personal files.

2.

Insert the HP Recovery media, and then restart the computer.
NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 102.

3.

Follow the on-screen instructions.
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Changing the computer boot order
If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive.
To change the boot order:
IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.
1.

Insert the HP Recovery media.

2.

Access BIOS:
For computers or tablets with keyboards attached:
▲

Turn on or restart the computer or tablet, quickly press esc, and then press f9 for boot options.

For tablets without keyboards:
▲

Turn on or restart the tablet, and then quickly hold down the volume down button; then select f9.
- or Turn on or restart the tablet, and then quickly hold down the Windows button; then select f9.

3.

Select the optical drive or USB flash drive from which you want to boot.

4.

Follow the on-screen instructions.
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Removing the HP Recovery partition (select products only)
HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.
IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 98.
NOTE:

The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Remove Recovery Partition, and then follow the on-screen instructions.
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14 Specifications
Computer specifications
Metric

U.S.

Width

33.80 cm

13.3 in

Depth

23.13 cm

9.09 in

Height (front to back)

1.95 cm

0.77 in

1.63 kg

3.6 lbs

Dimensions

Weight
Equipped with one memory module, WLAN module, and
mSATA drive
Input power
Operating voltage and current

18.5 V dc @ 3.5 A - 65 W
– or –
19.0 V dc @ 4.74 A - 90 W

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

‑20°C to 60°C

‑4°F to 140°F

Relative humidity (noncondensing)
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating

‑15 m to 3,048 m

‑50 ft to 10,000 ft

Nonoperating

‑15 m to 12,192 m

‑50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range of
temperatures.
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35.6-cm (14.0-in) display specifications
Metric

U.S.

Height

17.6 cm

6.93 in

Width

31.2 cm

12.28 in

Diagonal

35.7 cm

14.06 in

Number of colors

up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Pitch

0.197 × 0.197 mm

Format

HD, SVA (1366 x 768)

Configuration

RGB vertical stripe

Backlight

LED

Character display

80 × 25

Total power consumption

3.46 W

Viewing angle

±65° horizontal, ±50° vertical (typical)
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Hard drive specifications
500-GB*

320-GB*

Height

7 mm

7 mm

Length

100.4 mm

100.4 mm

Width

69.9 mm

69.9 mm

Weight

110 g

110 g

Interface type

SATA

SATA

Synchronous (maximum)

1.1 GB/sec

1.1 GB/sec

Security

ATA security or SED

ATA security

Single track

1.5 ms

1.5 ms

Average (read/write)

11/13 ms

11/13 ms

Maximum

22 ms

22 ms

Logical blocks

976,773,168

628,142,448

Disk rotational speed

7200 rpm

7200 rpm

Dimensions

Transfer rate

Seek times (typical read, including setting)

Operating temperature
*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications
180-GB*

256-GB*

Height

7 mm

7 mm

Length

100.5 mm

100.5 mm

Width

69.9 mm

69.9 mm

Weight

78 g

78 g

Interface type

ATA-7

ATA-7

Sequential Read

Up to 550 MB/s

Up to 460 MB/s

Random Read

Up to 50K IOPS

Up to 46K IOPS

Sequential Write

Up to 520 MB/s

Up to 260 MB/s

Random Write

Up to 80K IOPS

Up to 56K IOPS

Ready time, Maximum (to not busy)

2.0 s

4.0 s

Logical

0.1 ms

0.1

Total logical sectors

351,651,888

500,118,192

Dimensions

Transfer rate

Access times

Operating temperature
Operating
Non-operating

0° to 70°C (32°F to 158°F)
-55° to 95°C (-67°F to
203°F)

0° to 70°C (32°F to 158°F)
-40° to 80°C (-40°F to
176°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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mSATA drive specifications
24-GB*

32-GB*

256-GB*

Height

1 mm

1 mm

1 mm

Length

50.8 mm

50.8 mm

50.8 mm

Width

28.9 mm

28.9 mm

28.9 mm

Weight

< 10 g

< 10 g

< 10 g

Interface type

ATA-7

ATA-7

ATA-7

Sequential Read

Up to 160 MB/s

Up to 380 MB/s

Up to 490 MB/s

Random Read

Up to 128 MB/s

Up to 180 MB/s

Up to 480 MB/s

Sequential Write

Up to 115 MB/s

Up to 80 MB/s

Up to 250 MB/s

Random Write

Up to 16 MB/s

Up to 40 MB/s

Up to 100 MB/s

Ready time, Maximum (to not busy)

2.0 s

4.0 s

4.0 s

Logical

0.1 ms

0.1 ms

0.1

Total logical sectors

46,905,264

62,533,296

500,118,192

Dimensions

Transfer rate

Access times

Operating temperature
Operating
Non-operating

0° to 70°C (32°F to
158°F)

0° to 70°C (32°F to
158°F)

-55° to 95°C (-67°F to
203°F)

-40° to 80°C (-40°F to
176°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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0° to 70°C (32°F to
158°F)
-40° to 80°C (-40°F to
176°F)

15 Statement of Volatility
The purpose of this document is to provide general information regarding non-volatile memory in industrystandards based HP Business Notebook PC systems and provide general instructions for restoring nonvolatile
memory that can contain personal data after the system has been powered off and the hard drive has been
removed.
HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped
from HP assuming that no subsequent modifications have been made to the system and assuming that no
applications, features, or functionality have been added to or installed on the system.
Following system shutdown and removal of all power sources from an HP Business Notebook PC system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed
in the Maintenance & Service Guides available for HP PC products available on the product support pages at
www.hp.com.
1.

Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data.
Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.
a.

Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the
bottom of the display, or press the ESC key to display the start up menu, then press F10 . If the
system has a BIOS administrator password, enter the password at the prompt.

b.

Select the File menu, then Restore Defaults.

c.

Select the System Configuration menu, then Restore Security Defaults.

d.

If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the
tag, then press Enter to return to the prior menu.

e.

If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this
procedure if more than one hard drive has a DriveLock password.

f.

If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if more
than one hard drive has an Automatic DriveLock password.

g.

Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning
message.

h.

Select the File menu, then Save Changes and Exit.

i.

Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor,
one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor;
press F1 to accept or F2 to reject.
If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VProTM,
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System Configuration,
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then AMT Options. Then select Un-configure AMT on next boot. Select Save then Yes. Select the
File menu, and then select Save Changes and Exit. Reboot the system and confirm that you want
to un-configure AMT.

2.

j.

If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to de-activate
it.

k.

If the optional Absolute® Software Computrace® management and tracking service was activated
on the notebook PC, contact the provider to deactivate it.

l.

Remove all power and system batteries for at least 24 hours.

Remove and retain the storage drive or clear the contents of the drive.
a.

Hard Disk Drive (HDD)
Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that,
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.
To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when
prompted near the bottom of the display, or press ESC to display the start up menu, then press
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and
select the desired drive. For a higher level of protection, select Optimum.
NOTE: This process will take a long time, and the amount of time varies based on the hard drive
capacity.

b.

Solid State Drive (SSD)
Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by
powering on the system and pressing F10 when prompted near the bottom of the display. Select
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the
desired hard drive.

Non-volatile memory usage

Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Real Time Clock
(RTC) battery
backed-up CMOS
configuration
memory (CMOS)

256 Bytes

No

Yes

Controller (NIC)
EEPROM

64 Kbytes
(not customer
accessible)

No

Keyboard ROM

64 Kbytes
(not customer
accessible)

No
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Does this
memory
retain data
when power
is removed?

What is the
purpose of this
memory?

How is data input into this
memory?

How is this memory write
protected?

Stores system
date and time
and limited
keyboard
controller data.

Using the F10 Setup utility or
changing the Microsoft®
Windows® date & time.

This memory is not writeprotected. HP
recommends password
protecting the F10 Setup
utility.

Yes

Store NIC
configuration
and NIC
firmware.

Using a utility from the NIC
vendor that can be run from
DOS.

A utility is required to
write data to this memory
and is available from NIC
vendor. Writing data to
this ROM in an
inappropriate manner will
render the NIC nonfunctional.

Yes

Stores firmware
code (keyboard,
mouse, &

Programmed at the factory.
Code is updated when the
system BIOS is updated.

A utility is required for
writing data to this
memory and is available

Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of this
memory?

How is data input into this
memory?

battery
management).

How is this memory write
protected?
on the HP website. Writing
data to this ROM in an
inappropriate manner can
render the PC nonfunctional.

DIMM Serial
Presence Detect
(SPD)
configuration data

256 Bytes per
memory
module, 128
Bytes
programmabl
e (not
customer
accessible)

No

Yes

Stores memory
module
information.

Programmed by the memory
vendor.

Data cannot be written to
this memory when the
module is installed in a
PC. The specific write
protection method varies
by memory vendor.

System BIOS

4 to 5 MBytes

Yes

Yes

Store system
BIOS code and
PC
configuration
data.

System BIOS code is
programmed at the factory.
Code is updated when the
system BIOS is updated.
Configuration data and
settings are input using the
F10 setup utility or a custom
utility.

A utility is required for
writing data to this
memory and is available
on the HP website. Writing
data to this ROM in an
inappropriate manner can
render the PC nonfunctional.

Intel Management
Engine Firmware
(present only in
models ending in a
‘p’,‘w’, or ‘m’ or
with Intel Centrino
Pro technology)

1.5 or 5MByte

Yes

Yes

Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party data
store.

Management Engine Code is
programmed at the factory.
Code is updated via Intel
secure firmware update
utility. Unique Provisioning
Data can be entered at the
factory or by an administrator
using the Management Engine
(MEBx) setup utility. The third
party data store contents can
populated by a remote
management console or local
applications registered by an
administrator to have access
to the space.

The Intel chipset is
configured to enforce HW
protection to block all
direct read/write access to
this area. An Intel utility is
required for updating the
firmware. Only firmware
updates digitally signed
by Intel can be applied
using this utility.

Bluetooth flash

2Mbit

No

Yes

Stores
Bluetooth
configuration
and firmware.

Programmed at the factory.
Tools for writing data to this
memory are not publicly
available but can be obtained
from the silicon vendor.

A utility is required for
writing data to this
memory and is made
available through newer
versions of the driver if
the flash requires an
upgrade.

802.11 WLAN
EEPROM

4kb to 8kb

No

Yes

Stores
configuration
and calibration
data.

Programmed at the factory.
Tools for writing data to this
memory are not made public.

A utility is required for
writing data to this
memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.

Web Camera

64K bit

No

Yes

Store Web Cam
configuration
and firmware.

Using a utility from the device
manufacturer that can be run
from Windows.

A utility is required for
writing data to this
memory and is typically
not made available to the

Non-volatile memory usage 111

Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of this
memory?

How is data input into this
memory?

How is this memory write
protected?
public unless a firmware
upgrade is necessary to
address a unique issue.

Fingerprint Reader

512kByte
Flash

Yes

Yes

Stores
fingerprint
templates.

By enrolling in HP
ProtectTools Security
Manager.

Only a digitally signed
application can make the
call to write to the flash.

Questions and answers
1.

2.

How can the BIOS settings be restored (returned to factory settings)?
a.

Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b.

Select File, then select Restore defaults.

c.

Follow the on-screen instructions.

d.

Select File, save changes and exit, then press Enter.

What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?
The DIMM SPD memory contains information about the memory module such as size, serial number,
data width, speed/timing, voltage and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is
not installed in a PC. There are various third party tools available to read SPD memory.

3.

Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so
how?
The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the
write function.

4.

In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can
be written by the customer. Is this true for these BIOS chips?
Yes, they are flash memory chips.

5.

What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?
This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6.

Does resetting the CMOS configuration memory return the PC back to factory defaults?
The process of resetting the CMOS will return certain system settings to factory default but will not reset
many of the system data and configuration defaults to their factory settings. To return these system
data and configuration defaults to factory settings, refer to question and answer 1 and follow the
instructions for returning the BIOS settings to factory defaults.

112 Chapter 15 Statement of Volatility

16 Power cord set requirements
The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the country or
region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in
the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of
125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet
C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4
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Country/region

Accredited agency

Applicable note number

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a twopole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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17 Recycling
Battery
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the backlight to
avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only components
intended for recycling purposes are the LCD panel and the backlight. When you remove these components,
handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly that
might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see the
Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details, such
as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one computer
model to another.
Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.
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2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).

4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.
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6.

Remove the display panel assembly (2) from the display enclosure.

7.

Position the display panel assembly upside-down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
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12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Position the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.
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23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index
A
AC adapter, spare part numbers 22
AC adapter/battery light 10
antenna
removal 71, 72
spare part number 20, 71, 72
Antenna Kit, spare part number 20
audio, product description 2
audio-in (microphone) jack,
identifying 11
audio-out (headphone) jack,
identifying 11
B
Backup and Restore 92
backup tools 90
backups 98
creating 91
recovering 92
base enclosure
removal 53
spare part number 18, 53
battery
removal 29
spare part numbers 19, 29
battery bay, identifying 14
battery release latch 14
BIOS
determining version 74, 79, 85
downloading an update 75, 80,
85
updating 74, 79, 85
Blu-ray R/RE DVD±RW SuperMulti DL
Drive
precautions 25
Blu-ray ROM DVD±RW SuperMulti DL
Drive
precautions 25
Bluetooth label 15
boot order
changing 102
bottom 15
buttons
left pointing stick 6
left TouchPad 6

power 8
right pointing stick 6
right TouchPad 6
C
cables, service considerations 24
caps lock light, identifying 7
chipset, product description 1
components
bottom 13
display 5
front 10
left side 11
right side 12
top 6
computer major components 17
Computer Setup
navigating and selecting 73, 78,
83
restoring factory settings 74,
79, 84
computer specifications 104
connector, power 11
connectors, service considerations
24
D
display
specifications 105
display assembly
removal 67
subcomponents 20
display assembly components
removal 50
spare part numbers 50
display bezel
removal 50, 68
spare part numbers 20, 50, 51,
68
display component recycling 115
display enclosure, spare part
numbers 21
display hinge
removal 70
spare part number 20

display hinge cover
removal 70
Display Hinge Kit, spare part
number 20
display panel
product description 1
removal 51, 69
spare part number 50
spare part numbers 20, 51, 69
Display Panel Support Kit, spare part
numbers 21
DisplayPort
identifying 12
docking connector
identifying 12
Driver Recovery DVD,
creating 90
using for restore 93
drives, preventing damage 25
DVD-ROM Drive
precautions 25
DVD±RW Double-Layer with
SuperMulti Drive
precautions 25
E
electrostatic discharge 25
embedded numeric keypad,
identifying 10
equipment guidelines 28
esc key, identifying 9
Ethernet, product description
external monitor port 12

2

F
f11 recovery 93, 96
fan
removal 58
spare part number 18, 58
fingerprint reader board
removal 66
spare part number 18, 66
fingerprint reader, identifying 9
flash cache, product description 1
fn key, identifying 9
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function keys, identifying 9
G
graphics, product description 1
grounding guidelines 25
guidelines
equipment 28
grounding 25
packaging 27
transporting 27
workstation 27
H
Hard drive
spare part numbers 33
hard drive
precautions 25
product description 1
removal 33
spare part numbers 19, 21, 33
specifications 106
hard drive bay, identifying 14
hard drive bracket
removal 34
hard drive cover
removal 32
spare part number 32
hard drive cover, illustrated 18
Hard Drive Hardware Kit
spare part number 19, 22, 33
hard drive light 11
hard drive recovery 93, 96
headphone (audio-out) jack 11
heat sink
removal 62
spare part numbers 18, 62
HP PC Hardware Diagnostics (UEFI)
using 88
HP Recovery Disc Creator, using 90
HP Recovery Manager
correcting boot problems 102
starting 101
HP Recovery media
creating 98
recovery 101
HP Recovery partition
checking for presence 93
recovery 101
removing 103
using for recovery 93
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I
integrated webcam light,
identifying 5
internal display switch 5
internal microphones, identifying 5
J
jacks
audio-in (microphone) 11
audio-out (headphone) 11
network 12
RJ-45 (network) 12
K
keyboard
product description 3
remval 45
spare part numbers 18, 45
keypad
embedded numeric 10
keys
esc 9
fn 9
function 9
Windows applications 10
Windows key 9
L
labels
Bluetooth 15
regulatory 15
serial number 15
service 15
wireless certification 15
WLAN 15
latch, battery release 14
legacy support, USB 73, 78, 83
lights
AC adapter/battery 10
caps lock 7
hard drive 11
microphone mute 7
num lock 7
power 7, 10
RJ-45 (network) status 12
TouchPad 7
webcam 5
wireless 7, 10

M
mass storage device
illustrated 21
precautions 25
spare part numbers 21
memory card reader, identifying 12
memory module
product description 1
removal 39
spare part numbers 39
microphone
product description 2
microphone (audio-in) jack,
identifying 11
microphone module
removal 51
spare part number 20, 50, 51
microphone mute light, identifying
7
minimized image recovery 101
minimized image, creating 100
model name 1
mSATA drive
removal 35
spare part numbers 35
specifications 108
mSATA module
product description 1
N
network jack, identifying 12
num lock light 7
O
operating system, product
description 3
optical drive
precautions 25
original system recovery 100
P
packaging guidelines 27
plastic parts, service
considerations 24
pointing device, product
description 3
pointing stick 6
ports
DisplayPort 12
external monitor 12

product description 2
USB 3.0 charging (powered) 11
power button
identifying 8
power connector
removal 57
spare part number 57
power connector, identifying 11
power connector, spare part
number 57
power cord
set requirements 113
spare part numbers 22, 23
power lights 7, 10
power requirements, product
description 3
processor
product description 1
product description
audio 2
chipset 1
display panel 1
Ethernet 2
external media cards 2
flash cache 1
graphics 1
hard drive 1
keyboard 3
memory module 1
microphone 2
mSATA module 1
operating system 3
pointing device 3
ports 2
power requirements 3
processors 1
product name 1
security 3
serviceability 4
solid-state drive 1
video 2
wireless 2
product name 1
product name and number,
computer 15
R
recover
options

100

recovery 97
discs 99, 101
HP Recovery Manager 100
media 101
starting 101
supported discs 99
system 100
USB flash drive 101
using HP Recovery media 99
recovery media
creating 98
creating using HP Recovery
Manager 99
recovery media, creating 90
recovery media, using for restore
93
recovery partition 93, 96
removing 103
recovery tools 90
recovery tools, Windows 92
recovery, system 92
refresh 97
regulatory information
regulatory label 15
wireless certification labels 15
removal/replacement
procedures 29, 49
reset 97
restoring the hard drive 93, 96
RJ-45 (network) jack, identifying 12
RJ-45 (network) lights, identifying
12
RTC battery
removal 37
spare part number 18, 37
S
Screw Kit, spare part number 23
SD card insert, illustrated 18
security cable slot, identifying 11
security, product description 3
serial number 15
serial number, computer 15
service considerations
cables 24
connectors 24
plastic parts 24
service cover
removal 38
spare part number 18, 38

service labels, locating 15
serviceability, product description 4
setup utility
navigating and selecting 73, 78,
83
restoring factory settings 74,
79, 84
SIM slot, identifying 14
SIM, removal 30
slots
security cable 11
SIM 14
smart card 12
smart card board
removal 65
spare part number 65
Smart Card reader
spare part number 18
smart card slot, identifying 12
solid-state drive
precautions 25
product description 1
spare part numbers 19, 21, 33
specifications 107
speaker assembly
removal 64
spare part number 18, 64
speakers, identifying 14
specifications
computer 104
display 105
hard drive 106
mSATA drive 108
solid-state drive 107
Startup Repair, using 92
supported discs, recovery 99
Sure Start
using 87
system board
removal 59
spare part numbers 18, 59
system recovery 100
system restore point
creating 99
system restore point, creating 98
T
tools required 24
top cover, spare part numbers

18
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TouchPad
buttons 6
touchpad
removal 55
TouchPad light, identifying 7
TouchPad zone
identifying 6
TPM settings 86
transporting guidelines 27
travel battery connector,
identifying 13
traveling with the computer 15
U
USB 3.0 charging (powered) port,
identifying 11
USB 3.0 port 12
USB legacy support 73, 78, 83
USB ports, identifying 12
V
vents, identifying 11, 13
video, product description 2
W
webcam
identifying 5
spare part number 50
webcam light, identifying 5
webcam/microphone module
removal 51
spare part number 20
Windows
Refresh 97
Reset 97
system restore point 98, 99
Windows 7 operating system DVD
creating 90
using for restore 93
Windows 7 operating system media
creating 90
using for restore 93
Windows applications key,
identifying 10
Windows key, identifying 9
Windows operating system DVD 97
Windows Startup Repair, using 92
Windows tools
using 99
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wireless and memory module
compartment
identifying 13
wireless antenna
removal 71, 72
spare part number 20, 71, 72
Wireless Antenna Kit, spare part
number 71, 72
wireless antennas, identifying 5
wireless certification label 15
wireless light 7, 10
wireless, product description 2
WLAN antennas, identifying 5
WLAN device 15
WLAN label 15
WLAN module
removal 43
spare part numbers 18, 43
workstation guidelines 27
WWAN antennas, identifying 5
WWAN module
removal 41
spare part numbers 19, 41

